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PixTrix4
Focal points

Complex or ambiguous     
 photo? Eight simple 
 ways to put the reader’s 
 eye where you want it.

http://www.bamagazine.com
http://www.bamag.com/email/8riEdR/
http://www.bamagazine.com


®

2 of 11   

Blur the background

She’s clearly in front, but her colleagues in the fluores-
cent safety jackets are distracting.

Before After

Blur, and they fade away, leaving her center stage. Bonus: 
The short depth of field mimics how we actually see. 

(1) Select your object.

Photoshop

(2) Feather slightly. Inverse. (3) Blur the selection.
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Add a spotlight

Three attractive models compete for our attention. 

(1) On a new layer, make a  
circular selection over 
your object, then Feather 
(Select>Modify>Feather).

(2) Inverse the selection 
(Select>Inverse).

(3) Set the Foreground color 
to black, then fill (Edit>Fill). 
Deselect.

(4) Set the fill layer to Mul-
tiply mode, then reduce its 
opacity to about 75% (right).

Gradient spotlight  focuses on her; adds drama, intensity, interest.

Before After

Photoshop

3 of 11

http://www.bamagazine.com
http://www.bamagazine.com
http://www.bamag.com/email/8riEdR/


®

4 of 11   

Bring her forward

Six, same-size students are seen as a group. 

One is now the focal point. As you bring her forward, keep 
in mind that foreground objects appear lower in your visual 
field; move her feet down a lot and her head up a little (below).

Before After

(1) Extend the canvas size. (2) Select your object. (3) Scale it up.

Photoshop
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Five children are each wearing a different shirt color.

Shirt-color field intuitively 
draws attention to Miss Chan. 
For more contrast, make the 
others black & white (above).

Match a color

Before After

Sonja Taylor
“Flasp net exating end mist of it snooling. Spaff forl isn’t cubular but quastic, 
leam restart that can’t prebast. It’s tope, this fluant chasible silk.Texture and 

flasp net exating end mist of it snooling.”

David Aikman
“A card whint not oogum or bont. Pretty simple, glead and tarm. Texture and 

flasp net exating end mist of it snooling. Spaff forl isn’t cubular but quastic, 
leam restart that can’t prebast. It’s tope, this fluant chasible.”

Victor Sanchez
“It’s tope, this fluant chasible. Silk, shast, lape and behast the thin chack. It 
has larch to say fan. Why? Elesara and order is fay of alm. A card whint not 

oogum or bont. Pretty simple, glead and tarm.”

Five-color series highlights each child in turn.

Curved shape is soft and 
childlike and echoes the line 
of their heads.

Susan Fletcher
“Silk, shast, lape and behast the thin chack. “It has larch to say fan.” Why? 

Elesara and order is fay of alm. A card whint not oogum or bont. Pretty simple, 
glead and tarm. Texture and flasp net exating end mist of it snooling.”

Kimberly Chan
“Texture and flasp net exating end mist of it snooling. Spaff forl isn’t cubular but 
quastic, leam restart that can’t prebast. It’s tope, this fluant chasible. Silk, shast, 

lape tope this fluant and behast the thin chack.”
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Draw an outline

Our rooftop carrier is dwarfed by the big Jeep. This is 
how it looks in real life, but it’s not ideal for an ad.

Carefully traced outlines solve the problem beautifully. 
The Jeep’s still there for scale and fit, but our carrier is the 
center of attention. Below, two simple alternatives.

Before After

6 of 11
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Fade a section

Before After

Cool car, but what if we’re interested only in the front? Fade the rear into outlines, then add captions. It’s intrigu-
ing, and the reader’s attention is now where we want it.

Rubber Delore Texture Mist 
Texture and flasp net exating end mist of it snooling. 
Spaff forl isn’t cubular but quastic, leam restart that 
can’t prebast. It’s tope, this fluant chasible. Silk, shast, 
lape and behast the thin chack it has larch.

Windshield Delore Mist 
Texture and flasp net exating end mist of it snooling. Spaff forl isn’t cubular but 
quastic, leam restart that can’t prebast. It’s tope, this fluant chasible. Silk, shast, 
lape and behast the thin chack. It has larch to say fan elesara and order.

Lights Texture Mist 
Texture and flasp net exating end mist of it snooling. 
Spaff forl isn’t cubular but quastic, leam restart that 
can’t prebast. It’s tope, this fluant chasible. Silk, shast, 
lape and behast the thin chack. It has larch to say.

Engine Texture Delore Mist 
Texture and flasp net exating end mist of it snooling. 
Spaff forl isn’t cubular but quastic, leam restart that 
can’t prebast. It’s tope, this fluant chasible. Silk, shast, 
lape and behast the thin chack has larch to.

Frame Delore Texture Mist 
Texture and flasp net exating end mist of it snooling. Spaff forl isn’t 
cubular but quastic, leam restart that can’t prebast. It’s tope, this 
fluant chasible. Silk, shast, lape and behast the thin chack. It has larch 
to say fan elesara and order leam restart that can’t prebast.

Rg4500

(1) In Illustrator, trace 
the object. Give it a 
white background and 
import into Photoshop.

(2) In Photoshop, place the tracing 
on top of the photo layer. Make sure 
they both line up.

(3) With the tracing layer selected, click the Add layer mask 
icon (above). Set the Foreground color to black. Select a soft 
brush, and start masking away to reveal the photo.

Add layer mask
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Left, those eyes are intense, but so are the green background, 
glossy lips and dark hair. Let’s tighten the focus.

CRYSTAL BLUE®

BLUE IS THE NEW YOU.

Crop and color

(2) Eyedropper her hair color to fill the back-
ground. On the layers palette (below), click on the 
Adjustment Layer icon and 
select Black & White. Click 
OK. Set the Foreground 
color to black. Using a soft 
brush, paint over her eyes 
to restore the color.

Adjustment Layer

(1) Open the image in RGB mode. Crop. (3) Finish by coloring the type to match her eyes.

CRYSTAL BLUE®

BLUE IS THE NEW YOU.

Before After

Photoshop
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Guide with lines

Beautiful face. Where do we look? Curving lines say here. Note that VibrantPink words 
are differentiated by type weight only.

VibrantPink
The new lipstick for 2009

Two points make a perfect curve. With the Pen tool, click 
(1) and drag (2). Release. Click a second point (3) and drag (4). 
Adjust to suit. A perfectly smooth curve with no bumps!

1 3

4
2

Before After
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VibrantPink
The new lipstick for 2009

CRYSTAL BLUE®

BLUE IS THE NEW YOU.

Typefaces

1 Helvetica Neue Medium Extended

2 (a–b) Helvetica Neue Thin Extended

3 Planet Kosmos

4 VAG Rounded Black

5 VAG Rounded Thin

6 Futura Light

7 Futura Book

Images

Images: iStockphoto.com

8 (5136863)

9 (5516460)

10 (4501160)

11 (3529628)

12 (1518744)

13 (6556956)

14 (4433387)

15 (691320)

Article resources  

Colors
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C60 M18 Y27 K12

16
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6 7

3 10 1211
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Rubber Delore Texture Mist 
Texture and flasp net exating end mist of it snooling. 
Spaff forl isn’t cubular but quastic, leam restart that 
can’t prebast. It’s tope, this fluant chasible. Silk, shast, 
lape and behast the thin chack it has larch.

Windshield Delore Mist 
Texture and flasp net exating end mist of it snooling. Spaff forl isn’t cubular but 
quastic, leam restart that can’t prebast. It’s tope, this fluant chasible. Silk, shast, 
lape and behast the thin chack. It has larch to say fan elesara and order.

Lights Texture Mist 
Texture and flasp net exating end mist of it 
snooling. Spaff forl isn’t cubular but quastic, leam 
restart that can’t prebast. It’s tope, this fluant 
chasible. Silk, shast, lape and behast the thin chack. 
It has larch to say.

Engine Texture Delore Mist 
Texture and flasp net exating end mist of it snooling. 
Spaff forl isn’t cubular but quastic, leam restart that 
can’t prebast. It’s tope, this fluant chasible. Silk, shast, 
lape and behast the thin chack has larch to.

Frame Delore Texture Mist 
Texture and flasp net exating end mist of it snooling. Spaff forl isn’t 
cubular but quastic, leam restart that can’t prebast. It’s tope, this 
fluant chasible. Silk, shast, lape and behast the thin chack. It has larch 
to say fan elesara and order leam restart that can’t prebast.

Rg4500

Kimberly Chan
“Texture and flasp net exating end mist of it snooling. Spaff forl isn’t cubular 
but quastic, leam restart that can’t prebast. It’s tope, this fluant chasible. Silk, 

shast, lape tope this fluant and behast the thin chack.”
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Before & After magazine  
Before & After has been sharing its practical approach 
to graphic design since 1990. Because our modern world 
has made designers of us all (ready or not), Before & 
After is dedicated to making graphic design understand-
able, useful and even fun for everyone.  

John McWade Publisher and creative director
Gaye McWade Associate publisher
Dexter Mark Abellera Staff designer
 
Before & After magazine
323 Lincoln Street, Roseville, CA 95678 
Telephone 916-784-3880 
Fax 916-784-3995
E-mail mailbox@bamagazine.com  
www http://www.bamagazine.com

Copyright ©2008 Before & After magazine 
ISSN 1049-0035. All rights reserved 

You may pass along a free copy of this article to others 
by clicking here. You may not alter this article, and you 
may not charge for it. You may quote brief sections  
for review; please credit Before & After magazine, and  
let us know. To link Before & After magazine to your 
Web site, use this URL: http://www.bamagazine.com. 
For all other permissions, please contact us.

Subscribe to Before & After

Subscribe to Before & After, and become a 

more capable, confident designer for pennies 

per article. To learn more, go to  

http://www.bamagazine.com/Subscribe

E-mail this article

To pass along a free copy of this article to 

others, click here.

Join our e-list

To be notified by e-mail of new articles as  

they become available, go to  

http://www.bamagazine.com/email

http://www.bamag.com/email/9r7uVo/
http://www.bamagazine.com/Articles.asp?ID=106
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For paper-saver format  
Print: (Specify pages 13–18)

For presentation format  
Print: (Specify pages 1–11)

Before & After is made to fit your binder

Before & After articles are intended for permanent reference. All are titled and numbered.  

For the current table of contents, click here. To save time and paper, a paper-saver format of this article, 

suitable for one- or two-sided printing, is provided on the following pages.

Print 
Format: Landscape  

Page Size: Fit to Page

Save
Presentation format or  

Paper-saver format
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B
lur th

e b
ackgroun

d

Feather and Inverse. This 
activates everything except 
her.

B
lur

S
h

e
’s cle

a
rly in

 fro
n

t, but her colleagues in the fl uores-
cent safety jackets are distracting.

B
e

fo
re

A
fte

r

B
lu

r, and they fade aw
ay, leaving her center stage. B

onus: 
The short depth of fi eld m

im
ics how

 w
e actually see. 

(1) Select your object.

P
h

o
to

sh
o

p

(2) Feather slightly. Inverse.
(3) B

lur the selection.
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Focal pointsC

om
p

lex or am
b

igu
ou

s    
 p

h
oto? E

igh
t sim

p
le

 w
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u
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e read
er’s

 eye w
h

ere you
 w

an
t it.
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A
d

d
 a sp

otligh
t

Th
re

e
 a

ttra
ctive

 m
o

d
e

ls com
pete for our attention. 

(1) O
n a new

 layer, m
ake a 

circular selection over 
your object, then Feather 
(Select>

M
odify>

Feather).

(2) Inverse the selection 
(Select>

Inverse).
(3) Set the Foreground color 
to black, then fi ll (Edit>

Fill). 
D

eselect.

(4) Set the fi ll layer to M
ul-

tiply m
ode, then reduce its 

opacity to about 75%
 (right).

G
ra

d
ie

n
t sp

o
tlig

h
t focuses on her; adds dram

a, intensity, interest.

B
e

fo
re

A
fte

r

P
h

o
to

sh
o

p
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B
rin

g h
er forw

ard

S
ix

, sa
m

e
-size

 stu
d

e
n

ts are seen as a group. 

O
n

e
 is n

o
w

 th
e

 fo
ca

l p
o

in
t. A

s you bring her forw
ard, keep 

in m
ind that foreground objects appear low

er in your visual 
fi eld; m

ove her feet dow
n a lot and her head up a little (below

).

B
e

fo
re

A
fte

r
A

fte
r

(1) Extend the canvas size.
(2) Select your object.

(3) Scale it up.

P
h

o
to

sh
o

p
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F
ive

 ch
ild

re
n

 are each w
earing a different shirt color.

S
h

irt-co
lo

r fi e
ld

 intuitively 
draw

s attention to M
iss C

han. 
For m

ore contrast, m
ake the 

others black &
 w

hite (above).

M
atch

 a color

B
e

fo
re

A
fte

r

Sonja Taylor
“Flasp net exating end m

ist of it snooling. Spaff forl isn’t cubular but quastic, 
leam

 restart that can’t prebast. It’s tope, this fluant chasible silk.Texture and 
flasp net exating end m

ist of it snooling.”

D
avid A

ikm
an

“A
 card w

hint not oogum
 or bont. Pretty sim

ple, glead and tarm
. Texture and 

flasp net exating end m
ist of it snooling. Spaff forl isn’t cubular but quastic, 

leam
 restart that can’t prebast. It’s tope, this fluant chasible.”

Victor Sanchez
“It’s tope, this fluant chasible. Silk, shast, lape and behast the thin chack. It 
has larch to say fan. W

hy? Elesara and order is fay of alm
. A

 card w
hint not 

oogum
 or bont. Pretty sim

ple, glead and tarm
.”

F
ive

-co
lo

r se
rie

s highlights each child in turn.

C
u

rve
d

 sh
a

p
e

 is soft and 
childlike and echoes the line 
of their heads.

Susan Fletcher
“Silk, shast, lape and behast the thin chack. “It has larch to say fan.” W

hy? 
Elesara and order is fay of alm

. A
 card w

hint not oogum
 or bont. Pretty sim

ple, 
glead and tarm

. Texture and flasp net exating end m
ist of it snooling.”

Kim
berly Chan

“Texture and flasp net exating end m
ist of it snooling. Spaff forl isn’t cubular but 

quastic, leam
 restart that can’t prebast. It’s tope, this fluant chasible. Silk, shast, 

lape tope this fl uant and behast the thin chack.”
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D
raw

 an
 outlin

e

O
u

r ro
o

fto
p

 ca
rrie

r is dw
arfed by the big Jeep. This is 

how
 it looks in real life, but it’s not ideal for an ad.

C
a

re
fu

lly tra
ce

d
 o

u
tlin

e
s solve the problem

 beautifully. 
The Jeep’s still there for scale and fi t, but our carrier is the 
center of attention. B

elow
, tw

o sim
ple alternatives.
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Fad
e a section

B
e

fo
re

A
fte

r

C
o

o
l ca

r, but w
hat if w

e’re interested only in the front? 
F

a
d

e
 th

e
 re

a
r in

to
 o

u
tlin

e
s, then add captions. It’s intrigu-

ing, and the reader’s attention is now
 w

here w
e w

ant it.
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o
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g
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S

p
a
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u

b
u
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u
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u
a
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a
m
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a
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c

a
n

’t p
re

b
a

st. It’s to
p

e
, th
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a

n
t c

h
a
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le

. S
ilk, sh

a
st, 

la
p

e
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n
d
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e

h
a

st th
e

 th
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h

a
c

k. It h
a

s la
rc

h
 to

 sa
y.
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e

t e
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ist o
f it sn

o
o
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g

. 
S

p
a

ff fo
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u

b
u

la
r b

u
t q

u
a
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, le

a
m

 re
sta

rt th
a

t 
c

a
n

’t p
re

b
a

st. It’s to
p

e
, th

is flu
a

n
t c

h
a

sib
le

. S
ilk, sh

a
st, 

la
p

e
 a

n
d
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e

h
a

st th
e

 th
in
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h

a
c
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a

s la
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h
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F
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x
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re
 M
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n
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t e
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n
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ist o
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o
o
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g
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p

a
ff fo
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’t 

c
u

b
u

la
r b

u
t q

u
a

stic
, le

a
m

 re
sta

rt th
a

t c
a

n
’t p

re
b

a
st. It’s to

p
e

, th
is 

flu
a

n
t c

h
a

sib
le

. S
ilk, sh

a
st, la

p
e

 a
n

d
 b

e
h

a
st th

e
 th

in
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h
a

c
k. It h

a
s la

rc
h

 
to

 sa
y fa

n
 e
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sa
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n
d

 o
rd

e
r le

a
m
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sta

rt th
a

t c
a

n
’t p

re
b

a
st.

R
g
4
5
0
0

(1) In Illustrator, trace 
the object. G

ive it a 
w

hite background and 
im

port into P
hotoshop.

(2) In P
hotoshop, place the tracing 

on top of the photo layer. M
ake sure 

they both line up.

(3) W
ith the tracing layer selected, click the A

dd layer m
ask 

icon (above). Set the Foreground color to black. Select a soft 
brush, and start m

asking aw
ay to reveal the photo.

A
dd layer m

ask
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Left, those eyes are intense, but so are the green background, 
glossy lips and dark hair. Let’s tighten the focus.

C
RYSTA

L BLU
E

®

BLU
E IS TH

E N
EW

 YO
U

.

C
rop

 an
d

 color

(2) Eyedropper her hair color to fi ll the back-
ground. O

n the layers palette (below
), click on the 

A
djustm

ent Layer icon and 
select B

lack &
 W

hite. C
lick 

O
K

. Set the Foreground 
color to black. U

sing a soft 
brush, paint over her eyes 
to restore the color.

A
djustm

ent Layer

(1) O
pen the im

age in R
G

B
 m

ode. C
rop.

(3) Finish by coloring the type to m
atch her eyes.

C
RYSTA

L BLU
E

®

BLU
E IS TH

E N
EW

 YO
U

.

B
e
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A
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P
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o
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o
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G
uid

e w
ith

 lin
es

B
e

a
u

tifu
l fa

ce. W
here do w

e look?
C

u
rvin

g
 lin

e
s say here. N

ote that V
ibrantP

ink w
ords 

are differentiated by type w
eight only.

V
ib

ra
n
tP

in
k

T
h

e
 n

e
w

 lip
stic

k fo
r 2

0
0

9

Tw
o

 p
o

in
ts m

a
k

e
 a

 p
e

rfe
ct cu

rve. W
ith the P

en tool, click 
(1

) and drag (2
). R

elease. C
lick a second point (3

) and drag (4
). 

A
djust to suit. A

 perfectly sm
ooth curve w

ith no bum
ps!

1
3

4
2

B
e

fo
re

A
fte

r
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Typ
e

fa
ce
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1 H
elvetica N

eue M
edium

 Extended

2 (a
–b

) H
elvetica N

eue Thin Extended

3 P
lanet Kosm

os

4 VA
G

 R
ounded B

lack

5 VA
G

 R
ounded Thin

6 Futura Light

7 Futura B
ook

Im
a

g
e

s

Im
ages: iStockphoto.com

8 (5136863)

9 (5516460)

10 (4501160)

11 (3529628)

12 (1518744)

13 (6556956)

14 (4433387)

15 (691320)

A
rticle

 re
so

u
rce

s  

C
o

lo
rs

C
15

 M
100

 Y
100

 K15

C
25

 M
100

 Y
25

 K10

C
60

 M
18

 Y
27

 K12

1617

18

17

16

18 91314 12a2b

6
7

3
10

12
11

8

R
g
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Kim
berly Chan

“Texture and flasp net exating end m
ist of it snooling. Spaff forl isn’t cubular 

but quastic, leam
 restart that can’t prebast. It’s tope, this fluant chasible. Silk, 

shast, lape tope this fl uant and behast the thin chack.”
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